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Outline

e Previous Lab: Tools for Top-Down Web Services and
AreaService Example with clients

e Top-Down Web Services (cont’d)
— Math Web Service

— Loan Web Service

e Web Services Clients: Soap and Php
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Eclipse Axis2 Lab Example
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Lab Example Description

e Create a web service:
— takes as input two integers
— Returns the sum of the two integers
— Returns the multiplication of the integers

e The Web Service will also have to be developed in Eclipse (as
a Dynamic Web Project) using the top-down approach.
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Lab Assighnment

e Step 1: Interface of the Web Service
— Create the WSDL file for the Math Service
— Add 2 operations in the WSDL
e Add: operation that adds two integers
e Multiply: operation that multiplies two integers
e Step 2: Implementation of the service operations

— Use Axis2 and create a top-down web service from the
WSDL

— Implement the operations defined in the WSDL file in Java
— Test the Web service...
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Developing the Math Web Service

e Create a new Dynamic Web Project called “Math”
e Create a folder WSDL on the Math project.

e Right click on this folder and then New—> Other - Web Services 2>WSDL
and name this file MathService.wsdl.

e Add the operations to the WSDL File

25 MathService I €9 MathService
E MathSerice50AP 8 addOperation
http://localhost:B080/M... L] input parameters = [€] addOperation
]l output parameters | |[8| addOperationResponse
§# multiplhyOperation
Lxl input parameters | €] multiplyOperation
]l output parameters | [e| multiplyOperationResponse
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Developing the Math Web Service

e Both of these operations take as input 2 integers and return
an integer as a results.

25 MathService

= MathServiceSOAP

http://localhost:3080/M...

||£| acIcIDperaticn|

(8] multiplyOperation

6/5/2014

&9 MathService

¢ addOperation

L+l input parameters

|2 addOperation /

1 output parameters

|2| addOperatiocnResponse

8 multiplyOperation

[xinput pararmeters

[2] multiplyOperaticn

11 output parameters

[2] multiplyOperaticnResponse

e

(addOperationTyp
[e] inputl  int
- (&] input2  int

[e] addOperationResponse

(multiplyOperationType)

(2] input] int
- (8] input2  int
CS-5 | [e] multiplyOperationResponse

(addOperationResponseType)

oea IEI out |r|t

(multiplyOperationResponseType)

oaa IEI out |r|t




2 MathlfProcess.bpel

Developing the Math Web Service

S8 MathService.wsdl

25 MathService

= MathServiceS0AP
http://localhost:3080/M... -

£

Design | Source
£ Properties &3
= port
General

Documentation

Extensions

6/5/2014

El Console
Mame: MathServiceSOAP
Binding: | MathServiceSOAP

9 MathlfProcesshrtifacts.wedl

AddegE | http://localhost: 2030/ Math/services/MathService

Protocol:

SOAP

22 MathServicewsdl &2 = 0O
a.
€9 MathService
i addOperation
L+l input parameters (8] addCperation
11 output parameters (8] addOperationResponse
& multiplyQperation
L+l input parameters (8] multiplyCperation
11 output parameters (8] multiplyOperaticnResponse -
>
W
=
W
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Implementing the operations

e |Implement the multiply operation

3
i

,52 MathlfProcess. bpel B MathlfProcessirtifac B MathService.wsdl m MathServiceSkeleton, &5

&

public cla=ss MathServiceSkeletond

P

= mulciplyOperation
= multiplyOperationResponse

public org.example.www.mathservice. . MultiplyOperationResponse multiplyOperation

(

org.example.www.mathservice . MultiplvyvOperation multciplyOperation

MultiplyOperationResponse r = new MultiplyOperationResponse () !
r.zetfut (multiplyCperation.getInputl () *multiplyOperation.getInputs ()) !
retorn r;
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Implementing the operations

e Similarly implement the add operation in the
MathServiceSkeleton.java

public org.example.www.mathservice.hddOperationResponse addOperation
(

org.example.www.mathservice.hddOperation addOperation

)
i

AddOperationResponse r = new AddOperationBesponsel() !
r.setOut (addOCperation.getInputl () +addOperation.getInput2 ()} )
return r;
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Running the Math Project

e Right Click the Project and select Run As = Run on Server

e Restart the server if prompted to do so
—

P MathlfProcessArtifac P MathService.wsd| m MathServiceSkeleton. G Axis 2 - Home &3 z

B < | http://localhost:3080/Math/

" Apache Software Foundation

= http://www.apache.org/

Welcome!
Welcome to the new generation of Axis_ If you can see this page you have successfully deployed the Axis2 Web Application. Hower

working, we encourage you to click on the validate link.

ﬁthe available services deployed in this server.

« Validate
Check the system to see whether all the required libraries are in place and view the system information.

s Administration
Console for administering this Axis2 installation.
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Running the Math Project

>

J# MathlfProcessirtifac A MathService.wsd| [J] MathServiceSkeleton. g List Services 7 2

] =) r;é-"?* http://localhost:8080/ Math//services/list5ervices

e Apache Software Foundation

== http://www.apache.org/

Available services

@athﬁewicD

Service Description : Math Service

Service EPR : http://localhost:8080/Math/services/Math Service

Service Status : Active

Available Operations
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6/5

Running the Math Project > Test Web

Service

e Check if service is running

a — 4
¥ MathService.wsdl (m MathServiceSkeleton, (@ http://localhost:308 ({B Web Services Explore 232 P =
Web Services Explorer == S
4. Navigator o Actions =
£ WSDL Main 3 o _ A
F & file/C:fworkspace/Math/wsDL/] | <= WSDL Binding Details
= 2 MathService
SgL f'-.-'1ath':;-r:r-.-'|I:E':;-I_ZI AP Shown below are the details for this SOAP <binding> elernent. Click on an operation to fill in its
-4 addOperation parameters and invoke it or specify additional endpoints.
8 multiplyOperation
= Operations
=" add O peration --
multiphyOperation | --
T ——
= Endpoints Add Femove W
1 Status e
WABD3EI file:/ C:fworkspace/Math/WSDL/MathService.wsd| was successfully cpened. A
< > [WABD322] Endpoints were successfully updated. vili13




Running the Math Project > Test Web

Service Operations

e Test the addOperation

Web Services Explorer =N = =
%= Mavigator o Actions 1
E.E,WSDL Main Enter the parameters for the W5DL operation "addOperation” and click Ge to invoke,
[=- & filey/ T fworkspace/Math,/ WSDL/1 Endpoints ~
(= 2 MathService _ :
= [@ MathServiceSOAP Ihttp:.-".flcncaIhl:nst:BﬂSﬁ.-"Math.-"semces.fMathSen.rlceﬂ
ﬁ ||:_ - 1
@multipl}rﬂperatinn - Body
77 ™ addOperation
input] int
3
inputd int
4 W
i Status 1 &
Source A
- Bﬂdr
= addOperationResponse
N v

6/5/_

out (int): 7
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Running the Math Project > Test Web
Service Operations

e Test the multiplyOperation

S Mavigator o

Actions

@

£ WSDL Main

= & filey/ T fworkspace/Math,/WSDL/T
= 2 MathService

=& MathServiceSOAP

-§8 addOperation

O peration

Enter the pararneters for the W5DL operation "multiplyOperation” and click Go to invoke,

Endpoints
|7 Ihttp:,","lu:ucaIhu:ust:SﬂEﬂfMathIsern.rices.-"MathSern.riceﬂ

- Bﬂdr

multiplyOperation
inputl int
3

input? int
4

i Status

N

6[ JI LY Lt

- Bﬂd]’

= multiplyQperationResponse

ut (int): 12

o e NI —\J L

SOUrCE o

LI ] UI.IUUUI\IJ
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More Axis2 Web Services — Example 3

CS-592 Spring 2015 - Myron Papadakis
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Loan Example > Scenario

e Suppose that a client wants to request a loan from a bank

e The client sends the loan request and receives a response afterwards
whether the loan was approved or rejected.

e The client sends the following details when asking for a loan
— Name
— Address
— Age
— Annual Salary
— Amount Requested

e The bank returns a response to the client. If the loan is rejected for some
reason the bank also states the reason of the rejection
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Loan Example > Scenario

e The bank examines the loan request and either approves the loan or not.

e Age: If the applicant is under 18 years old or above 65 years old the
application is rejected. The response contains a message that informs the
applicant about the reason

e Annual Salary: If the annual salary is less than 20000 then the application
is rejected

e Amount Requested: If the amount that the client requests is greater than
the amount of loan based on years to pay off loan then the loan is not
appoved.

— limit = annualSalary * yearsToRepay * 0.5
— yearsToRepay = AVERAGE_LIFE_EXPECTANCY - applicantAge;
e Inany other case the application is approved.
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Steps to create the WS

e Create the XSD Schema (loan request and loan response)

e Create the WSDL Document for the Web Service and provide
the operations of the Web Service

— Set the types of the request and the responses of the Web
Service operations according to the XML Schema

e (Create the Web Service from the WSDL using Axis2 (top-down
approach)

e Implement the Web Service operations

6/5/2014 CS-592 Spring 2015 - Myron Papadakis 19



Eclipse Dynamic Web Project

e Create a new Dynamic Web Project in Eclipse
e Create a folder “WSDL” in the project

— In this folder we will place the XML schema and the WSDL
document itself.

e Create a new XSD document (LoanRequestor.xsd)
— File=>New—>0ther=>XML—2>XML Schema

6/5/2014 CS-592 Spring 2015 - Myron Papadakis 20



XSD Schema (1/6)

e Rightclick in the Types area and select “Add Complex Type”

and name it “processApplType” (will be used for the loan
request)

|S| LoanRequestorasd &2

[S] Schema : http:/www.example.org/LoanRequestor

== Directives

(&) Elements i =l Types

W

Add Simple Type

[

Show properties

il

Refactor 4

6/5/20 14 References Ib |




XSD Schema (2/6)

5| *LoanRequestorxsd 7

=
B

[5] Schema : http://www.example.org/LoanRequestor Types
2= Directives =
= irecive Add Element
=] Add Element Ref
fe| Add Any
— Add Attribute
@ Elements | Types
& Add Attribute Ref
p pplTyp - i
rcessﬁx IT:pe & Add Attribute Group Ref
A5 Add Any Attribute

Add Sequence
Add Choice
Add All

P

processfpplType

[e] name string
[e] address string

[e] age int
[e] annualSalary double

[e] amountRequested  double

6/5/2014 CS-592 Spring 2015 - Myron Papadakis
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XSD Schema (3/6)

|S| LoanRequestorxsd 2

|5] Schermna: http:/fwww.example.org/LoanRequestor

(2= Directives

(18 Elements | Types

[ —
processhpplType
C le|l AddElement >

] Show properties

Refactor 4

References »

|5] Schema : http:/fwww.example.org/LoanRequestor

(A= Directives

(€] Elements | | Types
i[8] processApplTypeElement : string H processApplType




XSD Schema (4/6)

Design Source|

(£ Markers | = Properties &2

[e] element

0]

General
Constraints
Documentation
Extensicns

Advanced

6/5/2014

[ Data Source E:(plorer] [E=1 Snippets | 55 Progresq El Console] B 1cpap Monitor] & Search]

= v =

Mame: processApplTypeElement

Type: string

. Browse... >
Minimum Cccurrence:

Mew...
boolean
date
dateTime

Magimum Occurrence:

Types

Mame (T = any character, * = any string):

Follow similar steps for
the response element..

[=] negativelnteger

=] NMTOKEMN

(=] NMTOKENS

[=] nonMegativelnteger
[=] nenPositivelnteger
[=] normalizedString
[=EINOTATION

=l positivelntagac—

—
@Eesmppﬁype - http:/fwww.example.org/LoanReque
e — T T T D PTTITY 2V LU

Zoio - imyiuil Papadakis
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XSD Schema (5/6)

|5| LoanRequestorasd i3 P LoanServicewsdl |5] Inline Schema of Loan5ervice.wsdl

6/5/2014

|S] Schema : http://www.example.org/Loan5ervice/

(A= Diirectives
(& Elements B Types processApplResponse
o@a B t 1
(8] processfpplicElernent : process8pplType processfpplResponse (€] response _ =tring
(8] processApplicRespElement : processApplResponse processfpplType | I
processApplType
[2] narne string
[e] address string
sea [e] age int
[e] annual5alary double

[e] amountRequested  double

CS-592 Spring 2015 - Myron Papadakis
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XSD Schema (6/6)

5] LoanRequestorxsd £3 . 22 LoanService.wsdl [5] Inline Schema of LoanService.wsdl

DI:'Q ||E| pracessﬁkpplicElementI—b

Design | Source
= Properties 1

(€] element

General
Documentation
Extensicns

Advanced

6/5/2014

processApplType

[2] name
[8] address
i [€] age
[e] annualSalary
[e] amountRequested

string
string
int
double
double

&l conscle
MName: processApplicElement
Type: tnsiprocessApplType

Minimum Occurrence:

Maximum Occurrence:

5] LoanRequestorxsd 23 P LoanServicewsdl [5] Inline Schema of LoanService.wsdl

=
(5]

[8] processApplicRespElement processApplResponse

el [€] response  string

Design | Source

= Properties &3 El Console

[e] element

General Mame: processApplicRespElement
Documentation | Type: tns:processhpplResponse
Edensions Minimum Occurrence:

Advanced

Maximum Occurrence:

CS-592 Spring 2015 - Myron Papadakis 26



Create the WSDL

e (Create the WSDL file for the Loan Web Service “LoanService.wsdl”
— Right Click = File 2 New = Other > WSDL

|5] LoanRequestorxsd

£5 LoanService

Er LoanServiceS0AP
http: /e example.crg)

S LoanServicewsdl 27

# LoanService

48 MewOperation

L+l input

parameters | €] MewOperation

1 cutput

parameters | €] NewOperationResponse

e Add asingle loanOperation (change the default operation)

6/5/2014

CS-592 Spring 2015 - Myron Papadakis
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Create the WSDL

|5] LeanRequestor.xsd AP LoanServicewsdl 2 = 0O
55 LoanService EI €9 LoanService
> LoanServiceSOAP §k loanOperation
http://www.example.org/ Cxlinput parameters | [€] loanOperation
1l output parameters [e] loanOperationResponse
< >

Design | Source
(21 Markers | =] Properties 3 Eﬂ Diata Source Explorer | = Snippets | 55 Progress El Console EI_TCF';'IF' Monitor| < Search

part

General Marne: parameters

Documentation Element:

T () Type (® Element >

e Must import the XSD file we created earlier on in order to use the request
and response elements...

Extensions

6/5/2014 CS-592 Spring 2015 - Myron Papadakis 28



WSDL File and XSD

El LoanRequestorxsd AP LoanService.wsdl @ Inline Schema of LoanSenviceawsdl &2 =L

S| Schema : (no target namespace specified)

(== Directives

4— LopanRequestorxsd Thttpy fwww.example.org/LoanService/

(&) Elements Types

<?xml wversion="1.0" encoding="UTF-&" standalone="no"?>
<wadl:definitions ®mlns:soap="http://schemas.xmlsoap.org/vsdl/soap/" xmlns:tns="http:/ /vwvv.cxample.org/LoanService/" xmlns:w

<#=2d:schema xmlns:xsd="http:/ /vwv.v3.0org/2001/XML5chama >
<xad:import schemalocation="LoanReguestor.xsd" namespace="http:/ /v¥v.example.org/LloanService,/ "></xsd: inport
</x=8d:=schema
</wadl:types>
<wadl:message name="loanlperationRegquest™>



WSDL File

e Use the XSD messages that you created earlier for the request and the
response accordingly.

e Do not forget to change the address of the LoanService (Properties View)
— http://localhost:8080/LoanWS/services/LoanService
— LoanWS: the name of the Eclipse Project

|S| LoanRequestor.xsd £ LoanServiceawsdl 2 = 0
25 LoanService EI ¥ LoanService
> LoanSeryiceSOap i loanOperation / o
httlﬂi.f.f|DC3|h'35t:3|3'ﬂm> L#]input [ paramet{ [e] processApplicElement
output | [ parametek\lilpraces&&pplic&esp Elernent
~— —

30

Design | Source


http://localhost:8080/LoanWS/services/LoanService

S| LeanRequestor.xsd

45 Loan5service

E» LoanServiceSOAP

http://localhost: 2080/ Lo...

WSDL File

P LoanServiceawsdl 7 @ Inline Schema of LoanService.wsdl

&% LoanService

3 loanOperation

[ input | [ parameters

[e] process&pplicElement

6/5/2014

processApplicRespElement

e| processhpplicRespElermnent

[]

| processApplResponse

E| response

string

http:/fwwew. example.org/LoanService,

M EE

CS-592 Spring 2015 - Myron Papadakis
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S| LeanRequestor.xsd

45 Loan5service

E» LoanServiceSOAP

P LoanServiceawsdl 7

WSDL File

@ Inline Schema of LoanService.wsdl

&% LoanService

3 loanOperation

http://localhost: 2080/ Lo...

[ input

| [ parameters

[e] process&pplicElement

6/5/2014

processApplicRespElement

rocessApplicRespElermnent

prucesmpplﬂespunse:

| response  string

http:/fwwew. example.org/LoanService,

M EE

CS-592 Spring 2015 - Myron Papadakis
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WSDL File

|S| LoanRequestor.sd 22 LoanServicewsdl &1

i85 Loanservice ] &9 LoanService
= LoanServicesOAP 48 loanOperation
http://localhost:8080/Le... - [#1input parameters | [€] processApplicElement
lloutput | [@ parameters (8] processApplicRespElement

Design | Source
1 Properties &3 El Console

= port

General Mame: LoanServiceSOAP

Documentation Binding: |LoanServiceSOAP

Add re@tp Jocalhost: 8080/ LoanWs/ services/Loan SEND
Protocol: |SOAP

Extensions
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Axis2 Web Service from WSDL

Web Services

Select a service implementation or definition and move the sliders to set the level of
service and client generation.

Web service type: |Top down Java bean Web Service W |

Service definition: | fLoanW5/W5DL/LoanServicewsdl v| | Browse... |

Start service
Configuration:

¢ 3
28 9

5

Client type: |Java Proxy

Server startup

Start the server from this page.

In order to proceed the server "Tomcat v7.0 Server at localhost” must be started.
Once the server is started the "next” button will be enabled.
The "back" button can be used while the server is starting to

change any previous settings in this wizard.

Mo client

Currently the server is starting.  Start server

Publishing to Temcat v7.0 Server at localhost...: WABD200! Starting server.

[ ] Publish the Web service



3ORY ORI ORI ORI ORI ORI

Implementing the operations

LoanRequestor.xsd 2P LoanService.wsdl 5] Inline Schema of LoanService.wsdl |J| LoanServiceSkeletonjava 7 = O
| A
¥ LoanServiceSkeleton.java

L}

package org.example.www.loanservice;
= J o

* LoanServiceSkeleton java skeleton for the axisService

= 7

0O m

2 public class LoanServiceSkeletond

F

I o Ln

* Anto generated method =signature
3 * Eparam processApplicElement
9 * return processhApplicRespElement
1 =
25 public org.example.www.loanservice.ProcessipplicRespElement loanCperation
3 (
4 org.example.www. loanservice.ProcessApplicElement processipplicElement
:'_ . ) C) org.example.www.loanservice.ProcessApplicElement W

—
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Implementing the operations

5] LoanRequestor.xsd 2P LoanServicewsdl 11| LoanServiceSkeletonjava = O
1k * huto generated method signature ~
1 = processApplicElement

[T B ]

Y U

1 & in

[T B ]

o
(LR FUR I I W U C R A R

]

=

processApplicRespElement

= public org.exanple.www.loanservice.ProcessApplicRespElement loanOperation
jorg.example.www.loanservice.ProcessApplicElement processApplicElement)

{

6/5/2014

ProcessApplicRespElement response = new ProcessApplicRespElement () ;
ProcessApplResponse r = new ProcessiApplResponse () !

int age = processApplicElement.getProcessApplicElement () .getige () ;
double amountRegquested = processipplicElement.getProcessaApplicElement () .getimountRequested () ;
double annualSalary = processipplicElement.getProcessApplicElement () .getAnnualSalary ()

CS-592 Spring 2015 - Myron Papadakis 36



Test if the WS is running

@ LoanRequestor.xsd AP LoanServicewsdl @ Inline Schema of Loan m LoanServiceSkeleton,

#5] (= .:éh http://localhost:B080/LoanW5/services/listServices

Available Operations
s getVersion

LoanService

Service Description : LoanService

Service EPR : http://localhost:8080/LoanW S5/services/Loan Service

Service Status : Active

Available Operations

s loanOperation

6/5/2014 CS-592 Spring 2015 - Myron Papadakis
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WS in the Web Services Browser

r- | e |
Z# LoanServicewsdl (m LoanServiceSkeleton. ({a List Services ({a Web Services Explore &3 ?y 8
Web Services Explorer == ST I

5. Mavigator .;éh & Actions @
5 WSDL Main -
- & .
(= A2 filey/ Cfworkspace/Loan WS/ WSD 2% Invoke a WSDL Operation Source ~
=2 LoanService
=@ LoanServiceSOAP Enter the parameters for the WSDL operation "loanOperation” and click Go to invoke.
| canOperation .
Endpoints
Ihttp:,".-"IDcalhnst:EﬂBGILDanWstewiceafLuanSewice
- Bﬂd]'
» processfpplicElement
name string
W
i Status &
WABD331 file:/C:fworkspace/LoanWs/ WSDL/LoanService.wsdl was successfully opened. A
< > [WABD322| Endpoints were successfully updated. W)
6/5/2014 CS-592 Spring 2015 - Myron Papadakis
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Testing the WS

P LoanService.wsd| I/m LoanServiceSkeleton. (ﬁ List Services (@ Web Services Explore 7

Co IR

Web Services Explorer
H5. Mavigator @h i Actions @
s% WSDL Main + Body n
= A2 file:/C/workspace/LoanWS/WSD
£ 2 LoanService * processApplicElement
= |8 LoanServiceSOAP _
55l oanOperation name string

address string

age int

annualsalary double

amountRegquested double

6/5/2014 CS-592 Spring 2015 - Myron Papadakis 39




6/5/2014

Testing the WS

CIIUpFUInL:

Ihttp:,","Iu:ucalhn:t:EﬂEﬂILDanWEIsewices.ananSer-.rice

~ Body

= processfpplicElerment

name string

lohn

address string

Paxou 17
age int
30

annualsalary double

25000

amountRequested double

10000

i Status

= processfpplicRespElernent
response (string): Loan Application APPROVED.

CS-592 Spring 2015 - Myron Papadakis
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Testing the WS

- Body

+ processfpplicElerment

name string

George

address string

Kapodistrias 21

age int
30

annualsalary double

12000

amountReguested double

10000

Go | Reset |

i Status

= processfpplicRespElermnent

response (string): Loan Application REJECTED - Reasen: Annual Salary $12000.0 too low. Annual Salary needs to be over $20000.0 to qualify)

6/5/2014 CS-592 Spring 2015 - Myron Papadakis
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Testing the WS

Actions

- Body

= processfpplicElement

name string

Mary

address string

Inatau 10
age int
67

annualsalary double
50000

amountReguested double

5000

Go | Reset

1 Status

= processfpplicRespElernent
6/5/2( response (string): Loan Application REJECTED - Reason: Owver-aged 67, Age needs to be under 63 years to qualify.

42



6/5/2014

Testing the WS

@ Invoke a WSDL Operation

Enter the parameters for the W3DL operation "loanOperation” and click Go to invoke.

Endpoints

I http://lecalhost: 2020/ Loa nWstemices..l‘LuanSemice

~ Body

+ processhApplicElement

name string

Helen

address string

Markao Polo
age int
17

annualsalary double

Status

= processApplicRespElement
response (string): Loan Application REJECTED - Reason: Under-aged 17, Age needs to be over 18 years to qualify.

CS-592 Spring 2015 - Myron Papadakis
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Testing the WS

Actions

I http://localhost: 23080/ LoanWs/services/Loan5ervice

~ Body

+ processfpplicElement

name string

Mikos

address string

Kapodistria 23

age int
43

annual5alary double
70000

amountReguested double

4000000

1 Status

= processfpplicRespElemnent
response (string): Loan Application REJECTED - Reason: You are asking for too much $4000000.0, Annual Salary $70000.0, Age 45 years. Your limit is 5873000.0
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Loan Client Example using PHP

For writing a client manually in Java or testing the Web
Service through the Web Services Browser, SOAP Ul see
the previous Assisting Lecture

CS-592 Spring 2015 - Myron Papadakis
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Prerequisites

e Php must be installed on your PC

e A program like XAMP or WAMP can be very helpful when
developing php and mysql applications

e Download wamp for example
e Work Done in C:\wamp\www

e Place a test.php there to see if php is running
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Php and SOAP

e Enable php_soap extensions(or delete the ‘;” from the
corresponding extension of the php.ini file)

e Native SoapClient, see http://php.net/soapclient

| [ |
Powered by Alter Way
E Localhost - [ [ |
% ] phpMyAdmin v php_mysqgli
www directory php_oci8
Apache '* php_oci8_11g

Version | e
PHP settings g =
Version » php_pdo_firebird

PHP extensions

|:| php.ini

|| PHP errorlog

PHP settings » php_pdo_mssgl

el e s v php_pdo_mysql

Start All Services

. 0 & Stop All Services | php.ini php_pdo_oci
B Restart All Services |:| PHP error log php_pdo_odbc
Lyf L e L nhn Adn rncal

Put Online
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http://php.net/soapclient

Steps

e A php client can be developed in a very similar way as any
other client (jsp client, java client, etc)

1. Check that the Web Service is running (check the wsdl file)

— Most common you will have to start Tomcat from the
Eclipse IDE (assuming that use one)

2. Develop the php client

— Using for example a simple editor like Notepad++
3. Test the Web service using the client

1. Through your Web browser (Firefox, Chrome, etc)
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Step 1

e Before testing your Web Service (either in php or wherever) always make
sure that the service is running.

e Otherwise you will retrieve a fault similar to the following one (after the

development of the client
r@npacheTomcatﬂ.ﬁ.SS—[ ®

C | [ localhost:8080/LoanWs/services/LoanService.wsd

HE Eqpoppoyeg [ Méog paKshog

This XML file does not appear to have any stvle information associated with it. The document tree is shown belc

wv<wsdl:idefinitions xmlns:wsdl="http://schemas.zmlsoap.org/wsdl/" xmlns:tns="http:/ v
*mlnz:zoap="http://schemas.xmlscap.org/wadl/soap/ " name="LoanService" targetHamespa
v<wadl: types>

w<x=d:schema xzmlns:ixsd="http://www.w3.o0rg/ 2001/ XMLSchema™>
<xsd:import namespace="http://www.exanple.org/LoanService/" schemalocation="Lo
</x=sd:schema>

</usdl:types> Error!SOAP-ERROR: Parsing WSDL: Couldn't load from

v<wsdl:message nam
e = 'http://flocalhost:8080/LoanWS/services/LoanService?wsdl' : failed to load
r<wsdl:imessage nam N = "
Cssarieess samee  €Xternal entity "http://localhost:8080/LoanWS/services/LoanService?wsdl"
/w=sdl :message
T:::wsd'_:pc:t?'ﬂ:e}:arr.e="lca:Se:"-:'_ce">
wv<wsdl:operation name="loanCperation">
<wadl:input message="tns:loanfperationBequest"></wsdl :input>
<wsdl:output message="tns:loanfperationResponse”></wadl i output>

< fradATl snrmeratinms
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Step 2

Create a php file in the folder you created previously (i.e. index.php)

(-I - 1 b ThisPC » O5(C) » wamp » www » loan
/ r= =
& 0 X W

I Favorites Mame

B Desktop || index.php

We want to create an input form (html) so that users provide their details
(name, address, salary, amount requested, etc)

— You can use some css to style the form etc (e.g. style.css)
The Web Service will be invoked when users submit their form

The Web Service responds and users see the result of the loan request
(approved or rejected and for which reason)

In the following slides, a simple example follows (note that | do not tackle
exceptional states, etc but you should do..)
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Index.php

<IDOCTYPE HTML:>
<html>
<head>
<link type="text/css" rel="stylesheet" href="style.css">
<meta http-egquiv="Content-Type" content="text/html; charset=utf-8">
<meta name="author" content="Myron Papadakis":>
<title>PHP Client for Loan Scenario</title>
</head>
<body>

<header class="main">

<hl>Loan Request</hl>

</header>
<section class="main">
<?php
if (isset (5 POST['name']) && isset($ POST['address']) && isset($ POST['age'])
&& isset($ POST['salary']) && isset($ POST['amcunt'])) {

Sname = $ POST['nams'];
$address = $ POST['address'];
Sage = $ POST['age'];

$salary = $ POST['salary'l;
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Index.php

Samount = § POST['amount']; array (size=1)

} 0 => string 'processApplResponse loanOperation(processApplType Sparameters)' (lsngth=62)

if (isset (5 _POST['submit'])){ /
Swsdl = 'http://localhost:8080/LoanWs/services/LoanService?wysdl”';

$debug = false;
try{
$client = new SoapClient ($wsdl);
if (Sdebug) {

var dump (5client-> getFunctions());

var dump ($client-> getTypes());

}

Sparams = array ('name' => Sname, 'add?

=» $Saddress, 'age' => Sage, 'annualSalary' => Ssalary, 'amou

Sresult = $client->loanOperation($params);

if (is soap fault(Sresult)) {

trigger error("SOAP Fault: (faultcode: {Sresult->faul

faultstring: {$result->faultstring})"”, E USER ERROR);

} array (size=Z2)

0 => string 'struct processfpplType {
string name;
string address;
} int age;
catch (Exception $e){ double annualSalary;

double amountReguested;
1" (length=114)

1 => =tring '"struct processfpplResponse |

string response;
(OO FAVE L} COTITL OPINIY LULY T IV P flength=48}

echo 5Sresult->»response;

echo "Error!™;

echo %e -»> getMessage ();




Index.php

2>
<form method="post" action="index.php">
<label>Name:</label>
<input name="name" placeholder="Goes Here">
<label>Address:</label>
<input name="address" placeholder="Goes Here">
<label>Age:</label>
<input name="age" placeholder="Goes Here">
<label>S8alary:</label>
<input name="salary" placeholder="Goes Here">
<label>Amount requested:</label>
<input name="amount" placeholder="Goes Here">
<input id="submit" name="submit" type="submit" wvalue="Submit">
</ form>
</section>
</body>
</html>
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Loan Request

Name:

Goes Here

Address:

Goes Here

Salary:

Goes Here

Amount requested:

6/5/2014

Step 3

<form method="post" action="index.php">
<label>Name:</label>
<input name="name" placeholder="Goes Here">
<label>Address:</label>
<input name="address" placeholder="Goes Here">
<label>Age:</label>
<input name="age" placeholder="Goes Here">
<label>S8alary:</label>
<input name="salary" placeholder="Goes Here">
<label>Amount requested:</label>
<input name="amount" placeholder="Goes Here">

Index.php (part)

<input id="submit" name="submit" type=submit" value="Submit">

</ form>

label {
display:block;
margin-top:10px; Styl e.CSS (p art)
letter-spacing:1px;

}

/* This section centers our complete page */
.main {
display:block;
Submit margin:0 auto;
width:500px;
}

/* This section centers the form inside our web page*/
form {

CS-592 Spring 2015 - Myron Papadakis
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Demonstration Example

Loan Request Loan Request

Name: Loan Application REJECTED - Reason: Annual Salary $10000.0 too low.
CsdStudent Annual Salary needs to be over $20000.0 to qualify.
Name:
Address: .
Goes Here
UoC Campus
Address:
Age: Goes Here
24
Age
Salary: Goes Here
10000
Salary:
Amount requested: Goes Here
Amount requested:
150000 Sut

Goes Here Submit
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References

e Top-down Approach:

http://www.eclipse.org/webtools/community/tutorials/TopD
ownAxis2WebService/td tutorial.html

e http://www.soapui.org/Working-with-soapUl/getting-
started.html

e http://php.net/manual/en/class.soapclient.php
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